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Chapter 1. Introduction

1.1. Intended Audience

The intended audience for this document are developers who wish to develop their first MicroEJ
plaform with MicroEJ SDK and deploy a MicroEJ standalone application onto. Notes:

« This document is for the STM32F746G-DISCO board.

« Thisdocument is not a user guide for the C development environment used for the final applica-
tion link. Please consult the supplier of the C development environment for more information.

+ Please visit the website https://developer.microej.com for more information about
STM32F746G-DISCO products (platforms, videos, examples, application notes, etc.).

1.2. Scope

This document describes, step by step, how to start your development with MicroEJ SDK
+ Create a MicroEJ platform for STM32F746G-DISCO board.
« Run a MicroEJ standalone application on the MicroEJ simulator.

« Run a MicroEJ standalone application on the MicroEJ platform and deploy it on the
STM32F746G-DISCO board.

1.3. Prerequisites

« PC with Windows 7 or later.

» The MicroEJ SDK environment must be installed.

+ STM32F746G-DISCO board.

« The STM32 ST-LINK utility (minimal version 3.7.1).

+ Keil MDK-ARM pVision 5.18.0.0 or higher. The Keil pVision evaluation version is 32KB code size

limited. To get a Keil pVision evaluation license for MicroEJ SDK, please consult the chapter
“Install Keil MDK-ARM”.




Chapter 2. Create and Use Your First
MicroEJ Platform

2.1. Create a MicroEJ Platform

The aim of this chapter is to create a MicrokJ platform from a MicroEJ architecture. The platform will
then be used to run a MicroEJ standalone application in subsequent chapters.

Although it is possible to use MicroEJ SDK to create every aspect of a MicroEJ platform in accordance
with specific requirements, in this chapter we will use a pre-packaged example of a MicroEJ platform
that is already configured for the STM32F746G-DISCO.

+ Open MicroEJ SDK.
+ Open the MicroEJ platform wizard: Fi | e > New > Pl atf orm.

« Select the MicroEJ architecture STMicroelectronics STM32F7J ARMCC from the combo box. A
MicroEJ Platform Reference Implementation is available:

Figure 2.1. MicroEJ Platform Reference Implementation Selection

0 Create a platform =] “
Create a platform

Create a new Platform.

Target

Architecture: | Platform Architecture Browse...

Create from a platform reference implementation.

4 (= Platform
4 B, Board

Includes:

- Microk) O5 Core Engine,

- Microk) Simulator,

- Foundation libraries (EDC, B-OMN, etc.),

- Multi Applications mode,

- Java to C interface modules (SMI, 5P, etc.),
- Serial Communication (ECOM, ECOM-COMM),
- GUI modules (Microll, MWT, etc.),

- Network modules,

- Metwork 551 modules,

- File System modules.

+ Select the MicroEJ platform Evaluation for the STM32F746G-DISCO from the combo box.

+ Clickon Next. Give aname which be used as prefix for all MicroEJ platform projects. Forinstance:
MyPl at f orm
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Figure 2.2. New MicroEJ Platform Naming

0 Create a platform o “

Create a platform

Create a new Platform.

Platform Properties

Device™ Platform
Mame™ MyPlatform
Version™: 2141

Provider®: MicroE]

Vendor URL: | http://developer.microgj.com/4.0/sdk/license

'/?:' < Back Next > Cancel

+ Click on Fi ni sh. The selected example is imported as several projects prefixed by the given
name:

+ STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCC5-configuration: Contains the plat-
form reference implementation configuration description. Some modules are described
in a specific sub-folder / with some optional configuration files (. properti es and /
or.xm).

« STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCC5-bsp: Contains a ready-to-use BSP
software project for the STM32F746G-DISCO board, including a Keil uVision project, an
implementation of MicroEJ core engine (and extensions) port on FreeRTOS RTOS and
the STM32F746G-DISCO board support package.

« STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCC5-fp: Contains the board descrip-
tion and images for the MicroEJ simulator. This project is updated once the platform is
built. It

The MicroEJ platform configuration file is automatically opened.

« From the MicroEJ platform configuration file, click on the link Bui | d Pl at f or m
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Figure 2.3. MicroEJ Platform Build

£} Overview

Platform Properties

Platform Content
heneral infarmation about this platform.

The content of the platferm is compesed of two parts:

Device: Board €2 Environment: select the architecture.

Name: MyPlatform ¢ Modules: select modules to import in the platform.
Version: 2.1.1 = =

rersen Platform Configuration

Provider : MicroE)

Once the content of the platform is chosen, it can be
. - - - configured.
Vendor URL: | http://developer.microej.com/4.0/sdk/license

£ Configuraticn

Each module can be configured creating a folder with its name
aleng the .platform file. [t could contain:

* an optional [module]. properties file,
* gptional module specific files and folders,

Modifying one these files requires to build the platform again.

Build

Generate and test the platform.

X Build Platform: The new platform is now available and
visible in Available Platforms

The build starts. This step may take several minutes. You can see the progress of the build steps
in the MicroEJ console. Please wait for the final message:

BU LD SUCCESSFUL

At the end of the execution the MicroEJ platform is fully built for the STM32F746G-DISCO board

and is ready to be linked into the Keil uVision project. Its name is STMB2F746GDI SCO- My-
Pl at f or m CMrhar df p_ ARMCCS.

The MicroEJ platform is now ready for use and available in the MicroEJ platforms list of your

MicroEJ repository (W ndows > Preferences > McroEJ > Platforns i n work-
space).

2.2. Run an Example on the MicroEJ Simulator

The aim of this chapter is to create a MicroEJ MicroEJ standalone application from a built-in example.

This example will initially be run on the MicroEJ simulator. Then, in the next section, this application

will be compiled and deployed on the STM32F746G-DISCO board using the MicroEJ platform.
2.2.1. Create Example

+ Open MicroEJ SDK.

« Openthemenu:File > New > M croEJ Standal one Exanpl e Project.
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+ Select the MicroEJ platform STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCC5 from the
combo box.

+ Select the example Sanpl es > CGetting Started > Hello Wrl d.

Figure 2.4. MicroEJ Standalone Application Selection

0 Mew MicroEl Standalone Example Project

- oEN
Select an Example > !

Target

Platform: | MicroE) Platform Browse...

a | [ Samples
4 =), Getting Started

= Hello World

This example prints Hello World on the standard output stream

'f?;' < Back Mext > Finish Cancel

+ Click on Next. The next page suggests a name for the new project.

Figure 2.5. MicroEJ Standalone Application Naming

% Mew MicroE) Example Project - g n

Create a MicroEJ Project »
Enter a project name.

Project Mame: | MyHelloWorldSample |

Yy ..
@) < Back Mext > Cancel

+ Click on Finish. The selected example is imported into a project with the given name. The main
class (the class which contains the mai n() method) is automatically opened.

2.2.2. Run Example

+ Select the project in the Package Explorer tree
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+ Right-click on this project and select Run As > M croEJ Application

Figure 2.6. MicroEJ Standalone Application Running

[% Package Explorer &2 = O [J] HelloWorld.java 532
== 28 * Java[]
= MyHelloWi—= 1 & mankans ~om =2t examples.edc.hello;
Mew »
Go Into
Open in New Window i=ssage "Hello World !
Open Type Hierarchy F4
lloWorld
Show In AltsShiftsw » [rOTOTIA A
2 Copy Ctrl+C ic void main(String[] args) {
t. intln("Hello World !");
E=  Copy Qualified Name out.printin("Hello Wor )
15 Paste Ctrl+V
W Delete Delete
Build Path >
Source Alt+Shift+5 »
Refactor Alt+Shift+T ¥
s Import...
iy Export..
i | Refresh F3
Close Project
Close Unrelated Projects
Assign Working Sets...
Run As » | E  1Java Applet Alt+Shift+X, A
Debug As v | @] 2Java Application Alt+5hift+X, )
Profile As v |\[T] 3 MicreE) Application Alt+Shift+X, M
Yalidate

_ Run Cenfigurations...
8 Build with EasyAnt

Restore from Local History...

@ JAutodoc L

The application starts. It is executed on the MicroEJ simulator of the selected MicroEJ platform
(STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCCS). The result of the test is printed in the
console:

Hello World !

2.3. Run the Example on the STM32F746G-DISCO
Board

2.3.1. Compile MicroEJ Standalone Application

« Opentherundialog(Run > Run configurations...).

+ Select the MicroEJ Application launcher Hel | oWér | d.
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« Open Executi on tab.

« Select Executi on on Devi ce.

Figure 2.7. Execution on Device

™ Run Canfigurations [ x |
Create, manage, and run configurations @
= X| B3 Name: | HelloWerld
type filter text 7] Main |4 Execution 313 Configuration | =, JRE E Source| [C] Common
[T] C/C++ Application Target
Ju JUnit Platform: | MicroEJ Platform Browse..

= Launch Group
4 [7] MicroEJ Application Execution

[3] HelloWorld ~ O
m () Execute on Simulator (®) Execute on Device

> g MicreE) Tool
Core Engine Mode: | Default ]

Default Settings: | Build & Deploy -

The application is generated, linked and deployed.

Options
Qutput folder: | S{workspace_locl/MyHelloWorldSample Browse...
[#] Clean intermediate files [verbose
Revert Appl
Filter matched 19 of 24 items = i
‘/?;‘ Run Close

« OpenConfi gurati ontabandsubmenuTarget > Depl oy.SelectCopy at | ocation
known by BSP proj ect

Figure 2.8. Deploy Configuration

0 Run Configurations n
Create. manage. and run configurations —
B S,
= X | =T Name: | HelloWorld
type filter text 7] Main | Execution [#13 Configuration . @, JRE| % Source| 5] Common
[E] C/C++ Application 4 Target Configuration
Ju JUnit > Deploy
= Launch Group Memory Means: | Copy at a location known by BSP project v
a [T MicroE) Application a Libraries
3] HelloWorld EDC
= Shielded Plug
» [ig MicroE) Tool
- . ECOM
Fs
> Microll
> Met
NLS
S5L
4 SOAR
Kernel
Revert Appl
Filter matched 18 of 23 items = PP
\/'_7:\ Run Close

+ Click Run: the application is compiled, and the compilation result (an ELF file) is copied into a
well known location in the workspace. The Keil uVision BSP project will search for it there when
it performs the final link.
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2.3.2. Link and Deploy MicroEJ Standalone Application

The aim of the final step is to:
« Compile the BSP project (such as drivers).

+ Link the BSP and the others libraries (MicroEJ Core Engine, C stacks, MicroEJ standalone appli-
cation etc.).

+ Deploy a MicroEJ standalone application on the STM32F746G-DISCO board.

@ Note

This final step uses Keil uVision 5.18.0.0.

The following steps are performed within MicroEJ.

+ In MicroEJ SDK, expand the project STM32F746GDISCO-MyPlatform-CM7hardfp_ARMCC5-bsp
and the folder Proj ect s/ STMB2746G- Di scovery/ Appli cati ons/ M cr oEJ/ MDK-
ARM A Keil uVision project file (Pr oj ect . uvpr oj x) is available.

Figure 2.9. Keil uVision Project Selection

a l=x STM32FT46GDISCO-MyPlatform-CMThardfp_ARMCCS-bsp
- = Drivers
- = Middlewares
4 = Projects
4 (= 5TM327466G-Discovery
4 (= Applications
4 (= Microk]
. = inc
inc-comm
= inc-fs
inc-hal
inc-net
inc-ssl
inc-ui
= includeAPls
= MDK-ARM
> = RTE
=| Project.uvopt:
startup_stm32fT460cs
(§ STM32746G_DISCOVERY _gspi.sct
(ﬁ STM32746G_DISCOVERY .sct

src

(T T TV T VT

% SFC-COMmM
src-fs
src-hal
src-kf
sre-net

- src-ssl

[ i T

% SFC-Ui
- = Utilities

Double-click on this file to open Keil uVision.

The following steps are performed within Keil uVision.
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* Figure 2.10. Keil uVision IDE

(V] - o IEN
File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
1 SHa| % | | | m | 55 = ) 2| @ NORMspinit VE e Qe o & &l
& E e Y | STM32746G_DISCOVERY |w! ,7;\‘ & @ " @y
Project L | ] microjvm_main.c - X
[SR"=] STM32746G_DISCOVERY o 16 L =/ ,\
L3 Drivers/STM32F T HAL | 17 wvoid microjvm main(void)
[0 Drivers/BSP/STM32746G_ 18 B4
1 Dri /BSB/C t 13 wvoid* wvm;
td Drivers/B3P/Components 20 int32_t err:
4 Drivers/CMSIS 21 int32_t exitcode;
LJ FreeRTOS 22
C3 LWIP/core 23 /{ create VM
24 vm = S5SNI teVM();
3 LWIP/corefipvd e - _creat=Vi(]
0 LWIP/netif 26 if (vm == NULL)
3 LWIP/api 27H {
I LWIP/port 28 printf ("VM initialization error.\n");
- 28 - 1}
3 wolfS5L =0 clse
[ FatFs 319 ¢
L1 FatFs/drivers 32 printf ("VM START\n"}):;
. P €TRA2T ISR §ikrane/Tn 33 err = SNI_startVM(wvm, O, NULL);
K | T N 34 “
EProJect @E-J:I‘:- {} Func... [],Timp‘.. < >
Build Qutput L x |

ST-Link Debugger

Build the Keil uVision project by clicking on the menu Proj ect > Build target. The
project is compiled and linked. See “Mandatory Connectors” to use the right connectors.

+ Deploy the link result on the STM32F746G-DISCO board by clicking on the menu FI ash >
Downl oad.

The application starts. The result of the execution is output on printf COM port. Congratulations, you
have deployed a MicroEJ standalone application on a MicroEJ platform.




Chapter 3. Specification

3.1. Overview

MicroEJ platform on STM32F746G-DISCO is based on board support package provided by STMicroelec-
tronics: STM32CubeF7. It includes FreeRTOS, a graphical user interface, a TCP/IP network connection,
a file system on microSD card, a serial connection and some custom GPIOs. MicroEJ platform has been
built against Keil pVision.

3.2. MicroEJ Platform Configuration

MicroEJ platform is based on MicroEJ architecture for STMicroelectronics STM32F7J.

Table 3.1. MCU Technical Specifications

MCU architecture Cortex-M7 (STM32F746NG)
MCU Clock speed 200 MHz
Internal Flash 1MB
Internal RAM 320 KB
External Flash 16 MB (QSPI)
External RAM 8 MB (SDRAM)

MicroEJ platform uses several architecure extensions. The following table illustrates the MicroEJ archi-
tecture and extensions versions.

Table 3.2. MicroEJ Configuration

Name Version
MicroEJ architecture 6.1.1
ul 7.2.1
Network 5.0.0
File System 211
HAL 1.0.2

3.3. Platform Output stream

MicroEJ platform uses USB Virtual COM port as output print stream. The virtual COM port is available
on USB ST-Link/V2 connector and it is connected to the MCU USART 1.

S Implementation Note

The COM port is also used as the output stream for the printf calls.

10



Specification

The COM port uses the following parameters:
+ Baudrate: 115200
+ Data bits bits: 8
« Parity bits: None
« Stop bits: 1

+ Flow control: None

g Implementation Note

On the STM32F746G-DISCO, the following parameters can be adjusted:
+ Baudrate
« Parity bits

« Stop bits

3.4. RTOS Configuration

MicroEJ platform uses FreeRTOS 8.2.1. RTOS uses a heap to allocate all its objects: tasks stacks, task
monitors, semaphores etc. The heap size is: 45 KB and is allocated in internal RAM. The following table
illustrates the available tasks and their stack size.

Table 3.3. FreeRTOS Tasks

Task name Size Priority
Core Engine 12 KB 11
Touch 512 bytes 12
Network Dispatch 2 KB 12
Network DHCP 512 bytes 8
Network Ethernet Link 512 bytes 9
Network Ethernet Input 350 bytes 14
LWIP TCP 1KB 13
File System 2 KB 12
MCU Charge Calculation 512 bytes 15
Framerate Calculation 512 bytes 3

3.5. Memories

MicroEJ Plaform uses several internal and external memories. The following table illustrates the MCU
and board memory layouts and sizes fixed by the MicroEJ platform.

11



Specification

Table 3.4. Internal RAM: DTCM (64 KB)

Section Name Size
Ethernet buffers 15560 KB
MicroEJ standalone application stack blocks 512 * n bytes ®
MicroEJ platform internal heap n bytes b

? nis the number of stack blocks defined in MicroEJ Application launcher options.
bh depends on memory configuration set in MicroEJ Application launcher options.

Table 3.5. Internal RAM: SRAM1 (240 KB)

Section Name Size
SSL buffers 65 KB
Any RW n bytes ®

2 n depends on MicroEJ application libraries used.

Table 3.6. External RAM: SDRAM (8 MB)

Section Name Size
Display buffers 510 KB
MicroUl working buffer 3MB
Multi applications working buffer 3 MB
MicroEJ standalone application heaps 1536 KB ?

2 Maximum size of the addition of MicroEJ heap size and MicroEJ immortal heap size. These sizes are defined in MicroEJ Appli-
cation launcher options.

Table 3.7. Internal flash: AXIM interface (1 MB)

Section Name Size

Any RO n bytes ®

? n depends on MicroEJ application, MicroEJ libraries, Board support package, RTOS, drivers, etc.

Table 3.8. External flash: QSPI (16 MB)

Section Name Size
MicroEJ standalone application resources n bytes ®
Pre-installed MicroEJ sandboxed application n bytes b

2 nis the size of all MicroEJ standalone application resources.
bn depends on the size defined in MicroEJ Application launcher options.

3.6. Multi Applications

This MicroEJ platform includes the Multi applications mode. Multi applications mode allow to build a
Multi applications firmware that can manage MicroEJ sandboxed application. Multi applications mode
requires a specific memory area to load MicroEJ sandboxed application. This memory area is located
in external SDRAM and its default size is 3 MB.
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3.7. Graphical User Interface

MicroEJ plaform features a graphical user interface. It includes a display, a touch panel, an user button
and a runtime PNG decoder.

3.7.1. Display

The display module drives a 480 x 272 TFT display. The pixel format is 16 bits-per-pixel: 5 bits for red
color component, 6 bits for green color component and 5 bits for blue color component. The display
device is clocked at 60Hz and the MicroEJ application drawings are synchronized on this display tick.

K

Implementation Note

The display stack implementation uses the double-buffering mode: the current MicroEJ
application renderingis performed in a background buffer (called back buffer) and anoth-
er bufferisused by the TFT display to refresh itself (called frame buffer). When the drawing
is done, a copy of pixels data from the back buffer to the frame buffer is performed (stack
copy). In order to avoid flickering, this copy is synchronized on display refresh tick.

Each buffer is allocated in external RAM (SDRAM). The size depends on the display size in
pixels and on the number of bits-per-pixel (BPP):

bufferSize = width * height * bpp / 8;,where:
« Wi dt his the display width in pixels: 480
« hei ght isthe display width in pixels: 272
+ bpp is the number of bits-per-pixel: 16

The bufferssizeis2 * 262120 = 510 KB.

The display module uses the STM32F7 hardware acceleration to perform some drawings: the ChromArt
(DMA2D). The DMA2D renders all fill rectangles (G aphi csCont ext . fi | | Rect angl e() ) and per-
forms the drawings of all images.

MicroUl requires a RAM buffer to store the dynamic images data. A dynamic is an image de-
coded at runtime (PNG image) or an image created by the MicroEJ application thanks the API
| mage. creat e(w dt h, hei ght).This bufferis located in SDRAM and the reserved size is 3 MB.

K

Implementation Note

This buffer is called "working buffer". An image buffer size follows the same rule than the
LCD buffer (see before).
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3.7.2. Inputs

Touch panel: All touch panel events are sent to the MicroEJ application thanks a Poi nt er event gen-
erator.

@ Implementation Note

Atouch press event is detected under interrupt. It wakes up a dedicated OS task. This task
is used to communicate with the touch (12C communication). For all next drag events, the
touch task runs in polling mode. When a release is detected, the touch task goes to sleep
and waiting a touch interrupt.

User button: The user button is reserved to the multi applications feature: it allows to force to kill a
sandboxed application.

@ Implementation Note

The user button event treatment is performed under interrupt.

3.8. Network

MicroEJ plaform features a network interface. A limited number of 10 sockets could be used for TCP
connections, 5 for TCP listening (server) connections and 6 for UDP connections. ADHCP client could be
activated to retrieve IP address. All DNS requests could be handled by a MicroEJ software implemen-

tation or a native one.

g Implementation Note

MicroEJ platform uses LwIP v1.5.0 fetched from git repository of the project. This imple-
mentation need a 50 KB internal heap to work. The TCP MSS is 1460 bytes.

The network portage use a BSD (Berkley Software Distribution) APl with select feature. A
mechanism named dispatch event, with a dedicated task, is used to request non blocking
operations and wait for completion or timeout.

The DHCP client is handled by LwIP and the DNS features use a MicroEJ software imple-
mentation.

3.9. File System

MicroEJ plaform features a file system interface. A microSD card is used for the storage (previously
formated to a FAT32 file system). Up to 2 files could be opened simultaneously.
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@ Implementation Note

MicroEJ platform uses FatFS R0.11. The FAT FS driver is the SD driver port of STM32Cube
v1.3.0.

3.10. Serial Communications

3.10.1. UART Connector

MicroEJ platform provides one serial communication (ECOM COMM) on UART6. UART6 pins are (RTS/
CTS mode is not used):

« TX: PC6; available on connector CN4 D1

« RX:PCT7; available on connector CN4 DO

g Implementation Note

This  implementation  uses interrupt and relies on the  MicroEJ
LLCOVM BUFFERED CONNECTI ON API. This API is FIFO oriented. It requires two dis-
tincts software buffer for reception and transmission: reception buffer uses 1024 bytes
and transmission buffer uses 5 bytes. These buffers are statically allocated in internal RAM.

3.10.2. USB Connector

MicroEJ platform features a serial communication (ECOM COMM) on USB port USBH: USB CDC. USBH
connector is CN12.

g Implementation Note

This implementation uses interrupt and using the MicroEJ
LLCOVM BUFFERED_CONNECTI ON API. This API is FIFO oriented. It requires two dis-
tincts software buffer for reception and transmission: reception buffer uses 1024 bytes
and transmission buffer uses 5 bytes. Additionnally the USBH_CDC drivers requires two
USB buffers of 64 bytes each. These buffers are statically allocated in internal RAM.

3.11. HAL

MicroEJ platform uses provides several GPI0Os to connect HAL foundation library. AllGPIOs are available
on ARDUINO connectors (CN4 to CN7). Digital pins are implemented by a GPIO access, analog input
pins (ADC) are driven by ADC channels of ADC 3 and analog output pins (DAC) drive PWM channels of
timers 1, 3,5and 12.

Each GPIO port / pin value is accessible by several ways:
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1. Using the global MCU declaration: all pins of all ports are grouped under only one virtual port
(port 0) and have consecutive values: PAQ has the ID 0, PA1, the ID 1, PA15 the ID 15, PBO the ID
16 and so on. For instance pin PF6is accessible by (0, 86) . This declaration is useful to target
all MCU pins using only one virtual port.

2. Usingthe standard MCU declaration: PortA has the ID 1, PortB the ID 2 etc. Each pin of each port
is a value between 0 (PortN-0) to 15 (PortN-15). For instance pin PF6 is accessible by (6, 6).
This declaration is useful to target a specific MCU pin.

3. Using the virtual board connectors. Board has 2 virtual connectors: ARDUINO digital port and
ARDUINO analog port, with respectively these IDs 30 and 31. For instance pin PF6 is accessible
on connector ARDUINO analog, pin A4: (31, 5). This declaration is useful to target a virtu-
al connector pin without knowing which MCU pin it is and on which physical connector pin is
connected.

4. Using the physical board connectors. Board has 3 connectors: CN4, CN5 and CN7 (CN6 is not
connected to the MCU), with respectively these IDs: 64, 65 and 67. For instance pin PF6 is acces-
sible on connector CN5, pin5: ( 65, 6) . This declaration is useful to target a physical connec-
tor pin without knowing which MCU pin it is.

The following table summaries the exhaustive list of GPIOs ports accessible from HAL library, and the
ranges of pins IDs:

Table 3.9. HAL GPIOs Ports and Pins

Port name HAL port ID Pins range
Global MCU virtual port 0 0to 143
MCU port A 1 O0to 15
MCU port B 2 O0to15
MCU port F 6 0to15
MCU port G 7 0to15
MCU portH 8 O0to 15
MCU port | 9 O0to15
Board virtual port 30 O0to 15
"ARDUINO digital"
Board virtual port 31 Oto7
"ARDUINO analog"
Board physical port "CN4" 64 1to8
Board physical port "CN5" 65 1to 10
Board physical port "CN7" 67 1to6

The following table illustrates the exhaustive list of GPIOs connected to the HAL library, their IDs ac-
cording the ports IDs and pins IDs (see before):
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Table 3.10. HAL GPIOs Declaration (port, pin)

Port / Pin MCU virtu- MCU port (2) Board virtu- .Board phys-
al port (1) al port (3) ical port (4)
PAO 0,0 1,0 31,0 65,1
PAS8 0,8 1,8 30, 10 67,3
PA15 0,15 1,15 30,9 67,2
PB4 0,20 2,4 30,3 64, 4
PB14 0,30 2,14 30,12 67,5
PB15 0,31 2,15 30,11 67,4
PF6 0, 86 6,6 31,5 65,6
PF7 0,87 6,7 31,4 65,5
PF8 0,88 6,8 3L,3 65,4
PF9 0, 89 6,9 31,2 65,3
PF10 0,90 6, 10 31,1 65,2
PG6 0,102 7,6 30,2 64,3
PG7 0,103 1,7 30,4 64,5
PH6 0,118 8,6 30,6 64,7
P10 0,128 90 30,5 64,6
PI1 0,129 9,1 30, 13 67,6
PI2 0,130 92 30,8 67,1
PI3 0,131 93 30,7 64,8

The following table lists the hardware analog devices (ADC / DAC channels) used by HAL analog pins:

Table 3.11. HAL Analog GPIOs Devices

Port / Pin ADC 3 channel PWM timer / channel
PAO 0 -
PA8 - 1/1
PB4 - 3/1
PB15 - 12/2
PF6 4 -
PF7 5 -
PF8 6 -
PF9 7 -
PF10 8 -
PH6 - 12/1

P10 - 5/4
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Chapter 4. Board Configuration

STM32F746G-DISCO provides several connectors, each connector is used by the MicroEJ Core Engine
itself or by a foundation library.

4.1. Mandatory Connectors

STM32F746G-DISCO provides a multi function USB port used as:
+ Power supply connector
+ Probe connector
« Virtual COM port

First of all, ensure the Power Supply jumper is fit to the second option: 5V Link. Then just plug a mini-USB
cable to a computer to power on the board, be able to program an application on it and to see the
MicroEJ standalone application Syst em out . pri nt traces.

Figure 4.1. Mandatory Connectors

Power supply jumper:
select "5V link"

Power supply / ST-LINK/V2 / Virtual COM Port

4.2. Communication Connectors

STM32F746G-DISCO provides several communication ports:
« Ethernet
+ Serial communication

« CDC communication
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Figure 4.2. Communication Connectors

UART6 RX
UART6 TX

|
z
38
§a
a

Ethernet CDC connector

4.3. HAL Connectors

STM32F746G-DISCO provides several HAL GPIOs on connector CN4 to CN7

Figure 4.3. HAL Connectors

CN5: ARDUINO
analog port

LELODOZELE ‘
2 | I

CN4-CN7: ARDUINO digital port
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Chapter 5. Keil MDK-ARM Configuration

5.1. Install Keil MDK-ARM

This section describes how to install a Keil MDK-ARM Development Kit, how to activate the MDK-ARM
license required for evaluating MicroEJ SDK and how to download the Keil pack related to the target
microcontroller.

A right to activate a MDK-ARM evaluation license is granted with the MicroEJ SDK evaluation version.
This evaluation license is a one month time limited that allows to compile and link up to 256KB of code.

5.1.1. Download Keil MDK-ARM

« Gotohttp://ww.keil.com deno/eval /arm htm
« Fulfill the registration form and press Subm t button.
« Download the executable file (e.g. MDKxyz. exe).

« Run executable file and follow installation steps. Install additional software and drivers if pro-
posed. A new application named Kei | uVi si on5 shall have been created.

5.1.2. Activate the Evaluation License

« StartKei | uVi si on5 application. If you are using Windows 7 or higher, you should run the
application with administrator privileges (right-click on Kei I uVi si on5 shortcut> Run as
adm ni strator).

« SelectFil e > License Managenent. .. and copy the computer ID (CID).
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Figure 5.1. Keil MDK-ARM Computer ID

License Management >
Single-User License l Floating License | Floating License Administrator ] FlexLM License ]

Customer Information Computer 1D

Comparny: ||'~“|'CFE=E~J Get LIC via Intemet... ‘
Email: |

Product | License ID Code... | Support Period
MDK-Lite Ewaluation Version

New License D Code (LIC): |

Evaluate MDK Professional Close Help

Gotohttps://ww. kei |l .com |license/install.htm

Fulfill the registration form with the computer ID and the following Product Serial Number
(PSN):

0YK7R- 4V1PQ R3KMWD

O Warning

This Product Serial Number is reserved to activate a Keil MDK-ARM product license
solely for a usage through this MicroEJ SDK evaluation.

Press Submi t button.
You should have received an email with an activation license.
Copy/Paste the license ID code (LIC) included in the email and press on Add LI Cbutton.

License is now installed and should display the information as shown below.
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Figure 5.2. Keil MDK-ARM License Installation

License Managermnent
Single-User License IHoz—.tnng‘LseI Foating License Administrator | FlexLM Llcmsel
Computer ID

— Customer Information
Name: | (CID: [cusxs-4582x
Company:  |MieroE Get LIC via bemet. |
Email: I
Product | License ID Code (LIC) Product variart | Support Period |

MDK-ARM Basic (256K) X4HWJ-DAWZ25-4X0U1-QVHEE47UGM-%IR30 Operation Expires: 31 Oct 2016

KAHWI-DZW25-4X0UN-QVHEE-47UGM-XIRS0 Add LIC I Urinztall...

Mew License |D Code (LIC):
= LIC Added Sucessfully =

Evaluate MDK Professional | Close | Help |

5.1.3. Install Microcontroller Specific Pack

« InKei |l uVision5,click on the pack installericon.
Figure 5.3. Keil MDK-ARM Microcontroller Pack

pVision

File Edit Wiew Project Flash Debug Peripherals Tools
MNMBHI| % B9 || P m R s s s
Kld 2 e o

iy Pack Installer
Install or update Software Packs that
contain Software Components

SVCS Window  Help

YY)

Project L x |

+ Click on the refresh icon Check for Updat es and wait until all available pack description

are downloaded.
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Figure 5.4. Microcontroller Pack Update

@81 Pack Installer - C:\Keil_vS\ARM\PACK

File Packs Window Help

Device:  ARM
Check for updates on web
Device /| Summary
=-T8 Al Devices 19 Devices
+1- @ ABOV Semiconductor 5 Devices
S 14 Devices
+ 7% ARM Cortex MO 1 Device
#-“f5 ARM Cortex MO plus 1 Device
= “% ARM Cortex M3 1 Device
+ 7% ARM Cortex M4 2 Devices
+ 7% ARM Cortex M7 3 Devices
#-“T5 ARM SCO00 1 Device
= % ARM SC300 1 Device
# 7% ARMv2-M Baseline 1 Device
+ 7% ARMvE-M Mainline 3 Devices

« In Devi ces tab, select the appropriate microcontrolleur part number Al | Devi ces
> STM cr oEl ect roni cs > STMB2F7 Series > STM32F746 >
STMB2F746NG > STMB2F746NGHX . In Packs Tab, select Devi ce Specific >
Kei |l : : STM32F7xxx_DFPandclickonl nstal | .

Figure 5.5. Microcontroller Pack Selection

(8 Pack Installer - C:\Keil_vS\ARM\PACK - [m] x

File Packs Window Help
Y | Device: STMicroelectronics - STM32F746NGHx

ﬂ Devices Boards ﬂ ﬂ Packs Examples ﬁ
Search: - X Pack Action Description
Device A o =1 Device Specific Da STM32FT46NGHx selected
T % Renesas 3 Devices = - Keil:STM32FToo DFP Mi(rne\e(truni(sSTM}ZFTSEriEsDEvi(ESuppurt, Drivers
+- @ Silicon Labs 397 Devices = Generic
W @ SONIX 49 Devices - ARMzCMSIS ! Update CMSIS (Cortex Microcontroller Software Interface Standard)
L % STMicroelectronics 229 Devices - ARM: CMSIS-Driver_Va... & _Install CMSIS-Driver Validation
5% STM32FO Series 23 Devices - ARMyCMSIS-RTOS Val... & _Install CMSIS-RTOS Validation
w5 STIM3I2F1 Series 95 Devices =~ ARM:mbedClient & _Install ARM mbed Client for Cortex-M devices
058 STMI2F2 Series 26 Devices - ARM:mbedTLS & _Install ARM mbed Cryptographic and SSL/TLS library for Cortex-M
5% STM22F3 Series 70 Devices - ARMminar & _Install mbed 05 Scheduler for Cortex-M devices
w52 STM32F4 Series 175 Devices - Keil: ARM_Compiler i Update Keil ARM Compiler extensions
%8 STMIIFT Series 56 Devices - Keil:Jansson & _Install Jansson is a C library for encoding, decoding and manipula
2% STM32FTAS 10 Devices - Keil:MDK-Middleware | Update | Keil MDK-ARM Professional Middleware for ARM Cortex-M
=% STM32FT46 16 Devices B hwl P2 hwlP @ Install IwlIP is a light-weight implementation of the TCP/IP protoc
w9 STM32ETA6BE 1 Device = Micriumz:RTOS & _Install Micriumn software components
4 % STM32FT468G 1 Device - Oryx-Embedded: Midd... §_Install Middleware Package (CycloneTCP, CycloneSSL and Cyclomi
w1 %% STM32F746IE 2 Devices B wolfSSLCyaSsL @ Deprecated| Light weight S5L/TLS and Crypt Library for Embedded Syste|
w9 STM32F7461G 2 Devices - wolfSSLiwolfSSL @ Install Light weight S5L/TLS and Crypt Library for Embedded Syste
2% STM32ETAGNE 1 Device - YOGITECH:RSTL_AR... | & Install VOGITECH fRSTL Functional Safety EVAL Software Pack for
2% STMIZE746NG 1 Device & YOGITECH:fRSTL ST... | & Install VOGITECH fRSTL Functional Safety EVAL Software Pack for
N STM32FT46NGHy ARM Cortex-M7, 216 ... 124
+-*t§ STM32F746VE 2 Devices
+- T8 STM32F746VG 2 Devices —
# % STM32FT46ZE 2 Devices
+-*t§ STM32F7462G 2 Devices
+ ‘1§ STM32FT56 8 Devices
w15 STM32F767 12 Devices
+-¥1§ STM32F768 1 Device il o

» The pack is downloaded and installed. Close the Pack Installer window.

5.2. BSP Project Structure

The MDK-ARM BSP project folder is included in a MicroEJ standard project. This project is visible from
the MicroEJ workspace. This project uses the same tree than the computer file system:

« Drivers: all MCU drivers, board drivers and CMSIS drivers
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« Middlewares: all 3rd-party files: USB host library, FatFs, FreeRTOS, LwIP
+ Projects: the MicroEJ platform project itself
« Utilities: miscellaneous C files required by drivers

The MDK-ARM BSP project file is Proj ect s/ STM32746G- Di scovery/ Applications/ M -
cr oEJ/ MDK- ARM Pr oj ect . uvpr oj x. This MDK-ARM BSP project has been written for pVision
V5.18.0.0. The project follows the files structure of STMCubeF7 projects:

« Drivers/*: all MCU drivers, board drivers and CMSIS drivers
+ FreeRTOS: FreeRTOS files
o LWIP/*: network LWIP files
« FatFS/*: file system files
« STM32_USBH/*: STMicroelectronics USBH drivers
« MicroEJ/*: all MicroEJ platform implementation files
The MicroEJ platform implementation files are grouped by MicroEJ features:
+ MicroEJ/Core: Core Engineimplementation over STM32CubeF7 and FreeRTOS (always required)
« MicroEJ/Comm: ECOM COMM implementation over UART and CDC
« MicroEJ/FS: File system implementation over FatFS
« MicroEJ/KF: Multi applications implementation over STM32CubeF7
« MicroEJ/HAL: HAL implementation over STM32CubeF7
« MicroEJ/Libs: MicroEJ platform C libraries
+ MicroEJ/Net: Network implementation over LWIP
« MicroEJ/Net/SSL: SSL implementation over WolfSSL

« MicroEJ/Ul: Ul implementation over STM32CubeF7
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Chapter 6. Changelog

6.1. Version 2.2.0

Initial release of the platform.
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